
12.05 Appendix-A, OrganAssistant™  
 

OrganAssistant™ is a software program created by Classic Organ Works™ as a convenient tool to 
handle MIDI systems on our organs. It runs on a Windows™ type of personal computer (PC) that can 
be connected to the MIDI Sequencer Input and Output connectors of the organ. 

 
The basic method of adjusting a MIDI stop in the organ is to alter one parameter at a time by entering 
the organ’s Set-Up mode and using various pistons, such as Up and Down, to select and modify the 
value of the parameter. See Section 4.11 of this manual. It is a tedious process and all too easy to make 
mistakes, especially if you are not versed in the peculiarities of MIDI. 

OrganAssistant was designed as a means to overcome all this by using a computer to display on the 
screen as many as ten MIDI stops at once, with all their parameters, and provide simple ways to 
individually adjust all their values. 

The program also allows all data in the organ’s memories to be downloaded and uploaded as well as 
providing a simple means to check on all the soft-switch settings. 

In addition, OrganAssistant can handle various operations associated with the MIDI sequencer built 
into later organs (using software version 6.10 or later and the CCC-6B control board). 

Four kinds of functions are provided for: 
1. Uploading and downloading organ memories. 
2. Editing MIDI stops (also Traps and Effects). 
3. Editing Soft-Switches. 
4. Editing Built-in Sequencer files. 

Organ memories include the contents of the Combination Action system, Crescendo settings, the 
Registration Sequencer, and MIDI stop parameters. 

System requirements are: 
1. Organ Firmware to be 4.41 or greater, (6.13 for Built-in Sequencer, requiring a CCC-6B). 
2. Windows PC™ 32-bit operating system. 
3. MIDI Interface. 
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Opening Screens 

The four basic types of operation are selected from the opening screen shown: 

 

 

Select one of the four functions and 
then configure the MIDI Interface 
device. 

The Exit button provides the only way 
to shut down the program at this 
juncture. 

Similarly, Help accesses the Help files 
where you can select a subject. Help 
screens are available from the Menu 
bar once you pick one of the four 
main functions. 

 

 

 

 

 

 

 

 

 

 

 

Setting Up the MIDI Interface 

The type of interconnection between the organ and the PC needs to be established. The following 
screen will appear in every function unless the devices are already chosen. You can access this screen 
from the Menu under Options if you need to change the settings. 

 

The MIDI I/O dialog box configures the Input and 
Output ports of your PC. Choose which devices you 
want to use for your MIDI Input and MIDI Output and 
then click on the “OK” button. 
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The Input Devices available are:  
MPU-401 

MPU401 is a standard developed by Roland ED in the early 80’s, and later adopted for Creative 
SoundBlaster cards, for MIDI (Musical Instrument Digital Interface) input (piano-like keyboards, etc.). 
MPU = MIDI Processing Unit. The DB15 Jack on the back of most soundcards is the MIDI port. Look 
for the driver on a floppy disk or CD that came with the soundcard. 

The Output Devices available are:  
Microsoft MIDI Mapper 
Microsoft  GS Wavetable SW Synth 
MPU-401 

If the MIDI Mapper device is chosen as the MIDI Out device, you can configure the MIDI Mapper 
device through “Start> Settings > Control Panel > Multimedia > MIDI”. 

The Microsoft MIDI Mapper remaps patches, notes, and channels, and adjusts velocities. It uses the 
Patch Map, Key Map and Setup to determine how to do this.  

Until recently, there wasn’t any standard for patch or note numbers. Now there is the General MIDI 
specification, an official specification published by the International MIDI Association. This standard 
does identify which instrument is to be used for each patch number. However, there are many MIDI 
sound files in circulation which do not follow the General MIDI specification. Playing these through a 
General MIDI device can make them sound pretty bad.  

Microsoft’s Specification 
Microsoft Corporation has produced their own version of the General MIDI specification, 
complicating things somewhat. The Microsoft standards require less of the equipment than the 
General MIDI standard. General MIDI supports 32 notes sounding at the same time on all 16 MIDI 
channels. Microsoft has defined two less capable devices – a “basic” device and an “extended” one.  

Basic Device  
A Basic device must be capable of playing 6 notes, in at least 3 different instruments, as well as 5 
percussion notes. All sound cards, including the original 8-bit sound cards, can do this. Basic 
devices play the melodic instruments on channels 13 through 15, with the drums on channel 16.  

Extended Device  
Extended devices must be capable of 16 melodic notes, using 9 instruments, plus 16 notes on 8 
percussive instruments. Extended devices use channels 1 through 9 for melodic sounds, with the 
drum track on channel 10.  

Microsoft’s Authoring Guidelines  
These guidelines provide for producing MIDI files that can play on any system by putting 2 copies 
of the song in each file – both a basic and an extended version. Each must meet the rules for its 
particular type, including placing the higher priority sounds on lower numbered channels. 

 
Alternatively, a MIDI-to-USB interface may be in use, in 
which case this type of screen will appear. Select the 
appropriate device. 
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When valid MIDI Input and Output devices have been chosen, the program will automatically try to 
Connect to the Organ. 

The Organ MUST already be ON at this point. 

Classic OrganAssistant will then automatically read the configuration from the organ appropriate to 
whichever of the four function buttons was selected and present that function’s opening screen. 
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1. Uploading and Downloading Memories 

This screen allows the user to backup organ information to a file on the computer’s hard drive and to 
restore organ information back to the organ at a later time. One of the primary uses of this software is 
to provide a computer backup of the organ’s information – if information is lost or is unintentionally 
modified, the user can restore a known configuration. 

The first thing to be done is to establish contact with the organ. The following screen will be displayed 
upon selecting Organ Memory Manager: 

 
Three organ parameters are displayed here: 

1. Organ Software Version: This is the organ’s major and minor version, and should be noted 
when requesting technical support (it should also be in the Organist’s Reference Manual). 

2. Combo Memory Banks: This is the quantity of Combination Action Memory banks (MEMory 
levels) configured in the organ (254 Max.). 

3. Crescendo Banks: This is the quantity of Crescendo Memory banks configured in the organ (4 
Max.). 

Choose a type of memory to handle (one memory level at a time). 
1. Combination memories (up to 254) 
2. Crescendo memories (up to 4) 
3. Registration Sequencer memory 
4. Configuration Data (Soft-Switches, etc.) 
5. Full Backup (all of the above) 
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How to Perform a Backup 
1. Select the Memory Type you wish to backup. If Combo Memory,  Registration Sequencer 

Memory or Crescendo Pedal Setup are chosen, you also need to select a Bank Number from the 
box that will show up to the right  side of the Memory Type box. 

2. Select the Action  button labelled “Backup”. 
3. Next, to the “To File:” label, click the Browse button. A standard File Save dialog box will pop 

up. By default the “coadata” subdirectory (in your Classic OrganAssistant install directory) is 
chosen. You can choose any other location if you wish. You should use a filename that includes 
a suitable reference as to the type of memory it contains. 

4. Click on the OK button. The Backup download will be performed. 

How to Perform a Restore 
1. Select the Memory Type you wish to restore. If Combo Memory, Registration Sequencer 

Memory or Crescendo Pedal Setup are chosen, you also need to select a Bank Number from the 
box that will show up to the right  side of the Memory Type box. 

2. Select the  Action button labelled  “Restore”. 
3. Next, to the “From File:” label, click the Browse button. A standard File Load dialog box will 

pop up. By default the “coadata” subdirectory (in your Classic OrganAssistant install 
directory) is chosen. Navigate to where your backup file is located and select it by either 
double-clicking on the file or by selecting the file and clicking on Open. 

4. Click on the OK button. The Restore upload will be performed. 

Both these operations may take several minutes if there is a lot of data. 

It is recommended that the organ memories be downloaded for back-up purposes on a regular basis – 
say, once every three months – just in case there is ever any trouble or prior to any upgrade. 
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2. Editing MIDI Stops 

Configuring MIDI stops is a tedious task. Organ Assistant makes it considerably easier by presenting 
up to ten stops with all their parameters on a computer screen where they may be easily adjusted by 
using a mouse to select values. 

Sounds (voices) available on a MIDI Expander are selected by MIDI-stops on the organ console, and 
these MIDI-stops may be controlled in the same manner as pipe ranks, or electronic stops. The MIDI-
stops will respond to the couplers, transposer, and expression pedals, in exactly the same way as other 
organ stops in the same division, i.e., they are fully integrated into the organ so that the organist need 
not be aware that they are generated by a MIDI source. A MIDI-stop will send an “initialization” 
message to the Expander when the stop is turned ON, to select the desired voice (Program), adjust 
volume, etc. The contents of the “initialization” message are fully programmable for each MIDI-stop. 

Using OrganAssistant, each MIDI-stop may be configured (differently on each memory level, if the 
organ’s Multi-MIDI function is On) by using the mouse to select parameter values.  

Most Expanders available today will respond to all sixteen (16) MIDI channels, and so may allow up to 
sixteen different stop sounds to be generated at once. However, this may not be practical due to the 
limited polyphony (quantity of simultaneous notes) of the Expander. Most GS-MIDI type expanders 
are capable of at least 24 notes, and some may produce 64 notes or more. 

A different MIDI channel should be assigned to each MIDI-stop Then a synthesizer may produce 
sounds for several different stops, distinguishing between the stops by the channel number that each 
is sending on. (Channel-10 should be avoided as it produces a different percussive sound for each key 
if a GM or GS-compatible MIDI device is being used).  

There can be up to 64 MIDI channels if all four MIDI expanders are connected. Each will handle 
sixteen consecutive channels (as programmed above) and these channels are translated automatically 
to 1–16 for each expander. Thus, Port-A handles 1-16, B has 17-32, C has 33-48 while D uses 49-64. 

While all the parameters for up to ten MIDI stops can be observed at once, only those for one selected 
stop should be adjusted. The parameters as set by the organ controls are: 

 
Item: Value: 
MIDI Channel number1 (A, B, C, D) 1–16, 17–32, 33–48 or 49–64 
Program Number2 to select voice 1–128 
Volume 0–127 
Pan (left-right) 0–127 
Modulation (tremolo) 0–127 
Expression (if not via swell shoe) 0–127 
Velocity sent with notes. 0–127 
Expression range3 0–127 
MIDI Controller used by expression 0–127 
Transpose (by semitones) –24 to +32 
Low Key 1–High Key 
High Key Low Key–85 
GS-MIDI Bank Select MSB 0–127 
GS-MIDI Bank Select LSB 0–127 
Velocity Enable4 0 or 1 
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There are some differences between the parameters as above and the Organ Assistant screen: 
1. MIDI Channel numbers A-D are actually Ports 1-4. 
2. Program Number is a Patch Number. 
3. Expression range has two settings, Minimum and Maximum, typically 50-127. 
4. Velocity Enable 0 or 1 is selected via a tick-box. 

MIDI Channels should be set as 1-64. Each block of 16 then comes out of a different port. 

 

Editing MIDI Stops with Organ Assistant 

Select MIDI-Stop Editor/Librarian 

Pick a MIDI-stop memory level. 

 

To select a MIDI-Stop Level greater than 1, turn on 
Multi-MIDI on the organ and change “Combo 
Memory Level” so that the MIDI memory tracks 
the Combination Action Memory level. 

 

 

The Editing screen will come up for that MIDI-stop level. The various menu items are: 

Choose from the File Menu: 
Open Memory Bank File  (Ctrl+O) 
Save Memory Bank File  (Ctrl+S) 
Save Memory Bank File As 
Load Memory Bank from Organ  (Ctrl+L) 
Write Memory Bank to Organ  (Ctrl+W) 
Exit. 

From the Edit Menu: 
Copy MIDI Tab   (Ctrl+C) 
Paste MIDI Tab   (Ctrl+V) 

View Menu: 
Quick Reference   (Ctrl+Q) 

Options Menu: 
MIDI I/O Setup   (Ctrl+M) 
MIDI Port Devices   (Ctrl+D) 
Shoe Names   (Ctrl+N) 

Select “File, Load Memory Bank from Organ” (or use the “Keyboard” icon) and the following type of 
MIDI stop data will be displayed: 
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The various icons at the upper left duplicate those found under the File Menu: 
1. Open Memory Bank File 
2. Save Memory Bank File 
3. Load Memory Bank from Organ 
4. Save Memory Bank to Organ 
5. Copy a MIDI Tab’s settings 
6. Paste/Write a MIDI Tab’s settings 
7. Set up MIDI Input and Output devices. 
8. Choose MIDI devices attached to up to four ports 
9.  Configure the Names of the organ shoes. 

If there are more than 10 MIDI stops, then the upper-right icons will select more screens. If fewer, 
there will be columns only for those present. Tab names (under Tab#) will be read from the organ. 

In each of the value fields (rectangular boxes containing numbers), you can manually enter a value, or 
you can use the up and down arrows. The selected stop’s Tab# will become white. 

The “Patch Names” value is chosen through a pull-down choice box. The patches are shown by name 
(as the diagram shows) rather than by number as in the organ setup system. Velocity Mode pull-down 
shows the expression shoe names while Expression Control offers the choice of Volume or Expression. 

The “Pan” control can also be modified through the slider control at the bottom. A value of 64 is the 
“Middle”, while “Fully Left” is 0, and “Fully Right” is 127. 
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How to Make Changes to MIDI Stops 

Before starting, verify the following: 
1. That the MIDI device is ON and connected to the Organ. 
2. Ensure that only the one MIDI stop to be adjusted is turned on! 

Then: 
1. Modify the on-screen settings for the one MIDI stop selected. 
2. Click on the “Preview” toolbar item, use Control-P, or “File > Preview Settings”. 
3. Play notes on the keyboard (within the low and high keys specified). 

You should hear the modified sound. If satisfied, turn off the MIDI stop and select another. 

The same kind of procedure also applies to MIDI Traps and Effects. Operate the control and adjust 
values while it is held on or played repeatedly. 

GM-MIDI does not use any banks. Set both “gsmidi msb” and “gsmidi lsb” to zero ‘0’. 

Making changes permanent 

When you are satisfied with the sound settings for a particular memory level, you can make them 
permanent by using the “Write Settings Permanently” toolbar item (looks like a lightning bolt), the 
“File > Write Settings” menubar item, or the Control-W shortcut, to send their new data to the organ: 

The program requests the memory level to which 
you wish to send data. 

Any time you want to change memory levels or 
exit the program, you will be asked whether you 
want to make the changes permanent or not. 

If you do not wish to hear the sounds, you can 
change as many parameters as you wish for any 
MIDI stops on-screen and upload the lot at once. 

 

Note that Multi-MIDI should be On (linked) 
otherwise there will be only one level of MIDI 
stops as found on organ Memory Level #1. If this 
box is deselected, the Combo Memory Level will 
become active and the MIDI-Stop values can be 
different on each Combo memory level. 

 

The settings are saved to the organ EEPROM and will be remembered even though the organ power 
may be removed. 

 

The following two tables show the standard GS-MIDI sounds generally available on any normal MIDI 
sound generator. Most custom generators also include these sounds but will probably have their own 
sounds available in different banks which must be set using “gsmidi msb” and “gsmidi lsb”. Refer to 
the appropriate generator manuals for further details. 
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General MIDI Standard Presets 
The following are Program numbers (Patches) for standard sounds available in any GS-MIDI 
Expander * on Channels 1–9, 11–16, of Bank-0, which may be connected to the organ. 

 
1 Acoustic Piano 33 Acoustic Bass 65 Soprano Sax 97 Synth FX 1 
2 Bright Piano 34 Electric bass (finger) 66 Alto Sax 98 Synth FX 2 
3 Electric Piano 35 Electric bass (pick) 67 Tenor Sax 99 Synth FX 3 
4 Honky tonk piano 36 Fretless bass 68 Baritone Sax 100 Synth FX 4 
5 Rhodes piano 37 Slap bass 1 69 Oboe 101 Synth FX 5 
6 Chorus piano  38 Slap bass 2 70 English Horn 102 Synth FX 6 
7 Harpsichord 39 Synth bass 1 71 Bassoon 103 Synth FX 7 
8 Clavinet 40 Synth bass 2 72 Clarinet 104 Synth FX 8 

9 Celesta 41 Violin 73 Piccolo 105 Sitar 
10 Glockenspiel 42 Viola 74 Flute 106 Banjo 
11 Music Box 43 Cello 75 Recorder 107 Shamisen 
12 Vibraphone 44 Contra Bass 76 Pan Flute 108 Koto 
13 Marimba 45 Tremolo Strings 77 Blown Bottle 109 Kalimba 
14 Xylophone 46 Pizzicato Strings  78 Shakuhachi 110 Bag Pipe 
15 Tubular bells 47 Orchestral Harp 79 Whistle 111 Fiddle 
16 Dulcimer 48 Tympani 80 Ocarina 112 Shanai 

17 Hammond Organ 49 String Ensemble 1 81 Synth Lead 1 113 Tinkle Bell 
18 Percussive Organ 50 String Ensemble 2 82 Synth Lead 2 114 Agogo Bells 
19 Rock Organ 51 Synth Strings 1 83 Synth Lead 3 115 Steel Drum 
20 Church Organ 52 Synth Strings 2 84 Synth Lead 4 116 Woodblock 
21 Reed organ 53 Choir Aahs 85 Synth Lead 5 117 Taiko Drum 
22 Accordion 54 Voice Ooohs 86 Synth Lead 6 118 Melodic Drum 
23 Harmonica 55 Synth voice 87 Synth Lead 7 119 Synth Drum 
24 Tango Accordion 56 Orchestra Hit 88 Synth Lead 8 120 Reverse Cymbal 

25 Nylon string guitar 57 Trumpet 89 Synth Pad 1 121 Guitar Fret Noise 
26 Steel string guitar 58 Trombone 90 Synth Pad 2 122 Breath Noise 
27 Electric Guitar (jazz) 59 Tuba 91 Synth Pad 3 123 Seashore 
28 Electric Guitar (clean) 60 Muted Trumpet 92 Synth Pad 4 124 Bird Tweet 
29 Electric Guitar (mute) 61 French Horn 93 Synth Pad 5 125 Telephone Ring 
30 Overdriven Guitar 62 Brass Section 94 Synth Pad 6 126 Helicopter 
31 Distorted Guitar 63 Synthbrass 1 95 Synth Pad 7 127 Applause 
32 Guitar Harmonics 64 Synthbrass 2 96 Synth Pad 8 128 Gunshot 

 
If you are setting MIDI stops at the organ, then these numbers must be used. When setting via 
OrganAssistant, their names are used (as found in a list in the “coadata” directory. If adding these to a 
file, the numbers start at 0. See adding Port Devices, below). 
Note: * These voices may not be exactly as described on all makes of expander. 

Similar GM-MIDI voices are grouped in blocks of 8. For example, all the woodwind reeds are in 65-72. 
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General MIDI Effects Presets 
The following are standard Drum and Percussion sounds, which are available on GM-MIDI sound 
generators on MIDI Channel 10. On this channel only, each key produces a unique sound effect. To 
access these, set a MIDI-stop to Channel 10 using Set-up Mode #20. (See Organist’s Reference Manual, 
Section 4.13.) 

 
MIDI 

# 
Note 

# 
Key 

Name 
Sound Effect Name MIDI 

# 
Note 

# 
Key 

Name 
Sound Effect Name 

35 0 B Acoustic Bass Drum *     
36 1 C Bass Drum 1 60 25 C Hi Bongo 
37 2 C# Side Stick 61 26 C# Low Bongo 
38 3 D Acoustic Snare 62 27 D Mute Hi Conga 
39 4 D# Hand Clap 63 28 D# Open Hi Conga 
40 5 E Electric Snare 64 29 E Low Conga 
41 6 F Low floor Tom 65 30 F High Timbale 
42 7 F# Closed Hi Hat 66 31 F# Low Timbale 
43 8 G High floor Tom 67 32 G High Agogo 
44 9 G# Pedal Hi Hat 68 33 G# Low Agogo 
45 10 A Low Tom 69 34 A Cabasa 
46 11 A# Open Hi Hat 70 35 A# Maracas 
47 12 B Low mid Tom 71 36 B Short Whistle 
48 13 C High mid Tom 72 37 C Long Whistle 
49 14 C# Crash Cymbal 1 73 38 C# Short Guiro 
50 15 D High Tom 74 39 D Long Guiro 
51 16 D# Ride Cymbal 1 75 40 D# Claves 
52 17 E Chinese Cymbal 76 41 E Hi Wood Block 
53 18 F Ride Bell 77 42 F Low Wood Block 
54 19 F# Tambourine 78 43 F# Mute Cuica 
55 20 G Splash Cymbal 79 44 G Open Cuica 
56 21 G# Cowbell 80 45 G# Mute Triangle 
57 22 A Crash Cymbal 2 81 46 A Open Triangle 
58 23 A# Vibraslap     
59 24 B Ride Cymbal 2     

 
Note: * To access MIDI #35 (which is below the bottom key on the keyboard) transpose down one octave and play low ‘B’. 
This voice may not be available on all expanders. 

Note: Some expanders may have additional sounds above and below these note numbers. 
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Using Port Devices 

As this system allows the MIDI stop to be pre-determined before uploading the data to the organ, it 
follows that the various patch names and other parameters must be stored in Organ Assistant and 
relate to specific sound generators only. These definitions are loaded from reference files. 

Choosing which MIDI device is hooked up to which MIDI port is done through the “Options > MIDI 
Port Devices” menu bar item. 

The devices specified in the “OrganAssistant.ini” file in the Classic OrganAssistant installation 
“coadata” directory can be chosen here. Highlight the MIDI device to be connected to each active port. 

 
Adding Port Devices 

By default, only a few types of MIDI devices are listed. This section describes how to add your own 
MIDI device. 

Open the file “OrganAssistant.ini” with a text editor and find the section “[Device List]”. This file 
describes the available MIDI devices that show up in the pull-down box. 
 [Device List] 
 Device1=General MIDI,genmidi.txt 
 Device2=Korg 01/W Bank A,korga.txt 
 Device3=Korg 01/W Bank B,korgb.txt 
 Device4=Proteus 1,prot1.txt 
 Device5=Undefined,undefined.txt 

You can add another device list in the following manner: 
1. Add another line to the list. For example, suppose your new device is called “My New Device” 

and its patch name list will be stored in a file called “newdevice.txt”. 

 Device6=My New Device,newdevice.txt 

2.  Create the file “newdevice.txt” in the Classic OrganAssistant install directory. The file will 
contain a list of patch names that can be found in the manual for the device. For example, in the 
“genmidi.txt” file used for the “General MIDI” patch list, the first few lines of the file are: 

 Acoustic Piano 
 Bright Piano 
 Electric Piano 
 Honky Tonk Piano 
 … 
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There should be a different patch name on each line of this file. The first patch is for program number 
0. The second patch is for program number 1, and so on. Whatever is included in this file will turn up 
in the drop-down boxes for the Patch so you could add reference numbers if you wish. The sound you 
get is determined by the line position in the list. There should be a basic file full of numbers (0-127) in 
the directory which can be copied as a starting point. You could, if you wish, use the file with numbers 
instead of names. Note that the Patch numbers in the General MIDI Standard Presets reference table 
start at 1, not 0, as this is how they are set from the organ’s controls. 

As there is no provision in the Setup screen for a choice of banks, you could have a different device 
and filenames for each bank and include the Bank Number in the Device Name. (an example above is 
Proteus 1). 

You can, of course, set a different bank in the Edit Organ MIDI-Stop screen for any stop but the sound 
you get may differ from the name in the drop-down box. 

 

Expression Shoe Names 

 
 

Names of the shoes of an organ can be modified through the “Options > Shoe Names” menu bar item. 

By default the names of the shoes are: 
 Shoe 1: Swell 
 Shoe 2: Choir 
 Shoe 3: Shoe #3 
 Shoe 4: Shoe #4 
 Shoe 5: Crescendo 

Modify the names by typing in the dialog boxes. Click on “OK” and then on “Write Memory Bank to 
the Organ” under the File Menu. 

These names are kept in a file in the “coadata” directory. 
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3. Editing Soft-Switches 

Organ Assistant provides a quick way to check on the states of all the soft-switches in the organ. 

Run Organ Assistant and pick Organ Soft-Switch Manager. A screen like the following will appear: 

 

 

 

 

 

It will be followed by this one: 

 

The various designations are taken directly from 
the organ firmware. 

You can check the state of all 96 soft-switches but 
you cannot change any of them here. To do that 
you must change them from the organ. Refer to 
Sections 8.02 and 8.03 in the Organist’s Reference 
Manual. 

If you make such changes, they will not show in 
the list until it has been refreshed (click on the 
Download icon shown here or on “File, Load 
Settings from Organ”).  

You can save the settings to a text file for 
reference by clicking on “File, Save Settings to a 
Text File”. 

There are 96 possible soft-switches.  
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4. Editing Built-in Sequencer files 

This feature is only of use if the console has the vacuum-fluorescent display that can show four 20-
character lines of data. Seven-segment displays cannot display this information. 

The sequencer MIDI files provide only a Song number for titles. Organ Assistant lets these be renamed 
with up to 20 characters. It also allows MIDI files to be downloaded for editing and uploaded again. 

 
Select Organ Sequencer Companion 

 
The choices are: 

1. Upload MIDI File to Organ – Organ 
Assistant allows you to upload the built-in 
sequencer’s files in MIDI format (type-0, 
single track) after editing by commercial 
software such as Cakewalk. You have the 
choice of uploading the proprietary CCC-
format file (.CCC) or a standard MIDI file 
(.MID). If the file was downloaded from the 
organ it will have been saved in both formats 
and the suffix will show either .CCC or .MID 
on just a single filename. Only .MID files can 
be edited with commercial software. Use the 
.CCC-format file if all you are doing is to 
rearrange the song list. If the file is just a 
MIDI file (.MID) it will be converted to a 
.CCC file for the sequencer during the upload. The window shows the lowest song number available 
but you can specify another one. If a full position is given, it will say that the slot is taken, and you 
will not be able to overwrite it. If OK clicked, the file will be uploaded and the list refreshed to 
show the current state. The organ display will show the song just uploaded as the current one. 

2. Download Performance from Organ – performance files are MIDI files. Selecting this button 
dumps the file to the PC and asks for a place and name to save it. The file is saved as two separate 
files with different suffices (.CCC and .MID) although it appears to have only the .MID suffix. You 
could then edit it in the .MID format using a program such as Cakewalk that can save it as a .MID 
file. .CCC files are unique to OrganAssistant and would be used only if re-arranging the play list. 

3. Rename Performance – allows you to rename any one file in the list. When OK clicked, it sends 
the revised list to the organ (which takes a few seconds) and the list displayed is refreshed to 
include the new name. 

4. Refresh List – updates the list of songs. 
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Editing Sequencer MIDI Files: 

Select the Download option. It will download the filenames from the organ. Only those with any 
content will be shown as numbered lines in a list. Each one should also have been named as “Song 
##”, but may simply be blank (or have had names added previously). Choose one of the songs, and 
pick a destination and a file name. The default filename will be that shown in the list (if any).  The file 
is saved to the PC in two forms: As a MIDI file (suffix .MID) and as a proprietary-format file (suffix 
.CCC). Only one such file name will be shown on the screen according to the type chosen in the 
window.  

Note that the filename should not exceed 20 characters if you intend to later upload the same name to 
the song list. The standard Windows characters are accepted and any non-standard ones will be 
stripped out. Do not start the name with a number. 

Edit the MIDI-format file with some suitable software such as Cakewalk and save it as a .MID file.  

Note that you cannot edit a .CCC-format file with commercial programs. 

Tip: If you intend to change channels numbers throughout the file, do each one in several steps. First change one 
lot to a number well away from anything existing (or even a letter combination), then the next lot to a different 
number, etc. Finally, change these numbers one lot at a time to what they should be. If you try to change 
numbers in one step you run the risk of duplicating channels because some will already be numbered with 
wanted numbers and you will not then be able to differentiate them from the new numbers. 

Select the Upload option and choose a MIDI file to upload. It will be a .MID file if it has been edited. 
Only Type-0 MIDI files are supported (single track). 

You will be presented with the number of the first empty slot in the sequencer memory to which you 
can save the file, but can change to another empty one. You will not be able to save to one with any 
content. You could erase a used one if need be (by using the built-in sequencer’s Erase commands). 

Click on OK to save with the current filename (having a .MID suffix) or rename it first (with a 
maximum of 20 characters). The file will be written to the flash memory and given the name of the file 
in the song list. The organ display will change to File Mode and show this information and the Song 
number will become current in the display. 

A proprietary .CCC file will be saved unchanged but a .MID file will be converted to the .CCC format. 
Any non-standard characters in the filename will be stripped out. 

You can upload a .CCC file in the same manner but, as this will not have been edited, the only reason 
for doing so is to save it to a new location if you want to rearrange a card’s contents or as an 
alternative way to rename it.  

You can upload a MIDI file made on a different organ – it may not play properly if stops are not in the 
proper places and/or there are different quantities of keyboards and/or stops. But it may be usable, 
particularly if you select MIDI Registration Off on the organ when you play the file. 
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Renaming Flash Files: 

Select Organ Sequencer Companion. This requests a connection and downloads a list of stored 
performances (songs) from the Flash card. It takes a few moments. 

The window shows a list only of song numbers having a content and their names (if any) alongside. 
Default names are of the form “Song nn”. As empty slots do not show, they cannot be accessed. 

Only those with any content will be shown as numbered lines in a list. Each one should also have been 
named as “Song ##”, but may simply be blank (or have had names added previously). 

Select the Rename option. 

Select a song to rename. Type a new name for that song and click on OK. You can only do one song at 
a time. 

Note that the filename should not exceed 20 characters if you intend to later upload the same name to 
the song list. Standard Windows characters are accepted and any non-standard ones will be stripped 
out. Do not start the name with a number. 
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Select a song and click on Download Performance from Organ: 

 

 

 

 

 

 

When all the data has been received the following type of screen will appear: 

 

The list contains only those song numbers 
that have any content. 

Select a song, #50 for example, click on 
“Rename Performance” and type in a new 
name with no more than 20 characters 
Example: “Renamed Performance”: 

Note: If you select Cancel, the song name will 
be sent as a blank line. 

 

 

 

 

 

 

 

 

 

 

 

Click OK. The revised song list will be 
uploaded to the organ and the screen will be 
refreshed: 
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Note: The new names are not kept in the Flash 
memory card but in the organ’s EEPROM so will be 
meaningless if you change the card or move songs 
around (by playing and resaving). Erasing a song 
from Flash will erase a renamed title. The title will 
also change if a new song is recorded in that location 
or if it is renamed (you will have to refresh the list to 
see such changes). 

 

You can always print the list from the 
computer (go to the pull-down File Menu), or 
save it (and give it a name).  

The list file is a normal text file so can be edited 
on the computer. The filenames should not 
exceed 20 characters. Standard Windows 
characters are accepted and any non-standard 
ones will be stripped out. 

Presently there are no facilities for uploading 
such a list back to the organ. 

 

 

 

 

 

 

 

 

 

 

 

Upload back to the organ. The current song name/number will appear in the bottom line of the console 
display which will have changed to the File Mode screen. If not, enter File Mode (by the PAUSE control).  
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Help 

The Organ Assistant Help Index allows you to find topics for further information: 

 

 
 

If you cannot find what you want, further information can be obtained from Classic Organ Works by 
telephoning 1-888-812-9717 during normal business hours (Eastern Standard Time) or by e-mail to 
info@organworks.com. 


